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Fiery Hot Folders

The Fiery Hot Folders application provides a quick and automated method of sending files to a Fiery server with
predefined settings, which eliminates repeatedly setting the same options for multiple jobs or frequently used
layouts.
The application lets you create as many Hot Folders as you want, each with a distinct profile of print settings for a
specific type of output. For each Hot Folder, you assign a Job Action that determines how the Fiery server handles
the job, which further streamlines the printing process. Using a Hot Folder, you can send files directly to the Fiery
server without starting the application in which the files were created. Because a Hot Folder can be shared on a
network, it provides an easy way to forward jobs without installing the application on the recipient’s system. When
you install Hot Folders on a system, any Hot Folder that you create resides as a special folder on your hard disk and
contains all the files and subfolders that contain information about your jobs.
A folder is considered "Hot" when it is:

• Connected to a Fiery server

• Monitored by the Hot Folders application

• Configured with predefined print options (optional)

• Configured with imposition settings (optional)

• Configured with file filters and application-specific formats (optional)

The Hot Folders software process runs in the background, continuously monitoring your active Hot Folders for new
jobs to print or process. The Job Action specified for the Hot Folder determines how the Fiery server handles the job.
The Hot Folders application monitors all Hot Folders created locally on your own system, but does not monitor Hot
Folders created on other systems.
The Hot Folders application includes the following:

• Fiery Hot Folders Console - Provides access to your Hot Folders and overview information about the location, Job
Action, and current settings for each Hot Folder.

• Status & Log - Monitor the status of files in progress and allow viewing of the log of all files processed through
your Hot Folders.

• Job Properties - provides access to the print options, including job presets, and imposition software.

• Input Formats - Provides access to filters and application-specific print settings, which you can set through a Hot
Folder without opening or installing the original application.

• Preflight Settings - Provides access to Preflight, which can be enabled to check submitted jobs for errors before
printing.

• Backup & Restore - Backs up and restores the Hot Folders that reside on your computer.

Fiery Hot Folders
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Fiery Hot Folders Console

The Fiery Hot Folders Console lets you access your Hot Folders and overview information about the location, Job
Action, and settings for each Hot Folder.
The Fiery Hot Folders Console provides access to Status & Log, which opens a separate window where you can
monitor and track all jobs processed through a Hot Folder.
The console includes the following:

• Menus - provides commands to create and manage your Hot Folders, to set preferences and to access Backup &
Restore.

• Taskbar - provides quick access to most of the commands in the menus, as well as Status & Log.

• Server list - lists all connected Fiery servers and associated Hot Folders. The server list can be collapsed or
expanded to display the Hot Folders connected to each Fiery server.

• Hot Folder summary - provides information about the configuration of the selected Hot Folder.

• Job properties - provides information about a subset of the Job Properties configured for the selected Hot Folder.

Note: The Fiery Hot Folders Console displays only a subset of Job Properties. To view a complete summary of Job
Properties, see Specify Hot Folder Job Properties on page 16.

Creating a Hot Folder

You can create as many Hot Folders as you want, each with a distinct profile of print settings for a specific type of
output.
When you create a new Hot Folder, the following apply:

• You connect the Hot Folder to a Fiery server.

• A new Hot Folder cannot have the same name as an existing folder.

• You cannot create a Hot Folder on a network drive, such as a common file server.

Each time you create a new Hot Folder, the Hot Folders application automatically creates supporting folders, one of
which stores the original files for jobs submitted to the Hot Folder after the jobs have printed (if Hot Folders
preferences are configured to save original files). The original files receive file names based on the current date and
time (YYYYMDHHMMSec).

Create a new Hot Folder

When you create a new Hot Folder, you specify job properties and other settings, determined by the connected Fiery
server.
1 In the Fiery Hot Folders Console, click New to display the Hot Folder Settings window.

2 Type a name for the Hot Folder in the Folder name field.

3 Optionally, type a description and details about the Hot Folder in the Description field.

Fiery Hot Folders
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4 Click Browse, and then specify the folder location.

5 Click Select to specify and connect to the Fiery server.
For instructions, see Connect a Hot Folder to a Fiery server on page 7.

6 Choose the Fiery server queue or action from the Job action menu.
For more information, see Specify the Job action for a Hot Folder on page 8.

7 Set any of these options:

• To specify Job Properties (print and imposition settings) for the Hot Folder, choose Define in the Job
properties menu.

• To specify Input Formats (filters and application-specific formats), click Edit next to Input formats.

• To enable a Preflight check of jobs submitted to the Hot Folder, select Preflight.

Note: Preflight is not supported for all Fiery servers.

• To set a time interval between checking for new jobs, click Advanced Settings, then click Custom and type a
new time interval.
If you plan to submit multi-part jobs to the Hot Folder, we recommend that you set this interval to 10 seconds
or more. For more information, see Submit multi-part jobs in a folder on page 13.

Connect a Hot Folder to a Fiery server

You can access the Connect to Server window in the Hot Folder Settings window of the Fiery Hot Folders Console.
From the Connect to Server window, you can specify, search for, and select from available Fiery servers, add them to
the Favorite list, and select a Fiery server from the Favorite list.
1 To open the Connect to Server window, click Select to the right of the Server name field in the Hot Folder

Settings window.

2 Do any of the following in the Connect to Server window:

• To specify a Fiery server by IP address or server name, type the IP address or server name in the Connect to a
server field. Click Connect to return to the Hot Folder Settings window.
If you type an IP address, the server list initially displays what you typed, but once the connection has been
authenticated, the IP Address switches to the Fiery server name in the server list.

• To search for and connect to a Fiery server, click the Search icon to open the Search window. Select the Fiery
server from the search results list, click Add, and then click Connect to return to the Hot Folder Settings
window.

• To connect to a Fiery server you select from the Favorite list, select the Fiery server name in the list, and then
click Connect to return to the Hot Folder Settings window.

• To add the specified Fiery server to the Favorite list, click the plus sign.

• To remove a Fiery server from the Favorite list, select the Fiery server name in the list and click the minus sign.

Fiery Hot Folders
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Connect an existing Hot Folder to a different Fiery server

Each Hot Folder must be connected to a Fiery server. The connection is set up when you create a new Hot Folder.
1 In the Fiery Hot Folders Console, select the Hot Folder and click Deactivate.

2 Click Edit.

3 Click Select to open the Connect to Server window.

4 Specify the Fiery server.

Specify the Job action for a Hot Folder

When you connect a Hot Folder to a Fiery server, you must also specify a Job action, which determines how the
Fiery server handles the job.
Some job actions might not be supported on your Fiery server, or they might be supported but not enabled.

1 Select the Hot Folder in the Fiery Hot Folders Console, and then click Edit.

2 In the Hot Folder Settings window, select one of the following from the Job action menu:

• Device name hold - Sends a job to the Hold queue, where it is spooled to the Fiery server hard disk and held in
the queue for printing at a later time.

• Device name print - Sends a job to the Print queue, where it is processed and printed in the order in which it
was received.

• Device name direct - Sends a job to the direct connection, where it is processed only when the Fiery server is
idle. If the Fiery server is busy, the job remains in the queue until the Fiery server is ready. The job is processed
as soon as the previous job is finished, before the next queued job is processed.
Jobs sent to the direct connection cannot be selected for reprinting, moving, or deletion, therefore the direct
connection provides a measure of security for sensitive or confidential files. Jobs sent to the direct connection
do appear in the Job Log, for accounting purposes.
When you choose the direct connection, Job Properties is disabled and Preflight is not available.

• Process and Hold - Processes a job and then places the processed job in the Hold queue for printing at a later
time.

• Print and Hold - Processes and prints a job, and then places the processed job in the Hold queue for reprinting
or later use.

• Print and Delete - Processes and prints a job, and then deletes the processed job. The job will not appear in the
Printed queue.

• Proof Print - Processes and prints one copy of a job. This job action is useful for checking the job output before
printing the number of copies called for in the job.

Fiery Hot Folders
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Set Hot Folders preferences

You can set preferences that apply to all Hot Folders.
1 In the Fiery Hot Folders Console, choose Edit > Preferences (Windows) or Fiery Hot Folders > Preferences (Mac

OS).

2 Set one or more of the following preferences:

• Units - If the Fiery server supports imposition, sets the default unit of measurement for use within Fiery
Impose.

• Time interval to check for jobs - Sets the default time interval to check for new jobs. Setting a longer interval
can prevent problems that may occur when processing large or multi-part files through a Hot Folder.

Note: You can override the default time interval in the settings for a specific Hot Folder.

• Save original files in - Specifies the location for archiving original files. By default, original files are archived in
the supporting folders that are automatically created inside the Hot Folder. If you specify a different location,
all original files from all Hot Folders will be saved in this common location.

• Clear original files - Sets the default time interval to wait before clearing the archived original files.

• Autorefresh Hot Folders linked server presets - Enables Hot Folders to update its display of a server preset’s
settings (in the Fiery Hot Folders Console) at a specific time interval.

Activating Hot Folders

Active Hot Folders are monitored by the Hot Folders application. Deactivated Hot Folders are not monitored.
The icons for Activate and Deactivate in the Fiery Hot Folders Console show as enabled or grayed out, according to
the status of the Hot Folder. If the Hot Folder is activated, you cannot select Activate. When the Hot Folder has been
deactivated, you cannot select Deactivate.
When you update the settings or Fiery server connection, or if you want to delete, edit, or rename a Hot Folder, you
must first deactivate the folder.

Activate or deactivate a Hot Folder

Active Hot Folders are monitored by the Hot Folders application. Deactivated Hot Folders are not monitored.

• Do one of the following:

• To deactivate a Hot Folder, in the Fiery Hot Folders Console, select the Hot Folder and click Deactivate.

• To activate a Hot Folder, in the Fiery Hot Folders Console, select the Hot Folder and click Activate.
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Stop and restart all Hot Folders

You can choose to stop monitoring your Hot Folders at any time and then restart them.
When you open the Hot Folders application, it continuously monitors your Hot Folders and processes all jobs
submitted to a Hot Folder. When you stop all Hot Folders, processing stops and all Hot Folders are disabled until you
restart them.

1 Click File > Stop All Hot Folders to stop all Hot Folders.

2 Click File > Start All Hot Folders to restart all Hot Folders.

When you restart all Hot Folders, all Hot Folders return to their previous state (activated or deactivated),

Manage Hot Folders

You can edit, duplicate, rename, and delete a Hot Folder.

Edit a Hot Folder

When you edit a Hot Folder, first deactivate it to take it offline, and then make changes by accessing the Hot Folder
Settings window.

Note: You can change the Job action, Job properties, Input formats, and Advanced Settings without deactivating the
Hot Folder, but you cannot change other settings.

1 In the Fiery Hot Folders Console, select the Hot Folder you want to edit and click Deactivate in the taskbar.

2 Select the Hot Folder you want to edit and click Edit.

3 Edit the settings as desired.

Any changes take effect immediately and apply to all subsequent jobs processed through the Hot Folder.

Duplicate a Hot Folder

You can duplicate the settings of an existing Hot Folder (activated or deactivated) to create a new Hot Folder.
1 In the Fiery Hot Folders Console, select the Hot Folder you want to duplicate and click Duplicate.

2 Change the name of the duplicate Hot Folder (if desired) and click OK.
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Rename a Hot Folder

When you rename a Hot Folder, first deactivate the Hot Folder, which takes it offline and prevents changes to a Hot
Folder that is in use. (A Hot Folder can be shared on a network). You can then rename the Hot Folder within the
Fiery Hot Folders Console.

Use the Fiery Hot Folders Console to rename a hot folder, not the Windows and Mac OS file renaming
features. If you try to rename a Hot Folder in Windows, you receive an error message, instructing you
to use the Fiery Hot Folders Console. If you try to rename a Hot Folder in Mac OS, no error occurs, but
the Hot Folder becomes invalid.

1 In the Fiery Hot Folders Console, select the Hot Folder to rename and click Deactivate on the taskbar.

2 Double-click the Hot Folder in the Fiery Hot Folders Console.

3 Type the new name in the Folder name field.

Delete a Hot Folder

When you delete a Hot Folder, you first deactivate it. You then delete it, which permanently removes the Hot Folder
and its supporting folders.
A Hot Folder can be shared on a network, so deactivating a Hot Folder prevents deleting a Hot Folder that is in use.

1 In the Fiery Hot Folders Console, select the Hot Folder you want to delete and click Deactivate.

2 Click the Delete icon.

3 Click Yes to confirm.

When you delete a Hot Folder, all files associated with the deleted Hot Folder, such as the job log, Fiery
server settings, and any files that have not been sent to the Fiery server, are deleted.

Access original job files

You can access original job files through the Fiery Hot Folders Console.
• Do one of the following:

• In the Fiery Hot Folders Console, select the Hot Folder and click Show Original files.

• From the desktop, double-click the Hot Folder, then double-click [_EFI_HotFolder_], and then double-click
[MoveFolder].
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Submitting jobs to a Hot Folder

You can submit one or more jobs from the Fiery Hot Folders Console or the desktop. Submitted jobs are sent to the
specified queue or processed according to the specified action.
Job Properties settings apply to the jobs submitted to the Hot Folder. If you set Default for Job Properties, jobs are
printed with the default settings of the Fiery server. If you choose a preset, jobs are printed with the preset settings.
For more information, see Job Properties on page 15.
The Preflight check detects potential job errors. You can configure which errors to check for and which action to
perform if a critical error is found.
For PDF jobs on Windows-based Fiery servers with Fiery system software FS500 Pro and later, you can use Fiery
Preflight Pro to perform these checks. For more information, see Fiery Preflight Pro on page 36.
Certain file formats comprise multiple files, some of which are not visible and which contain header and other
information. When using a Hot Folder to process multi-part jobs, submit all of the files for the job within a folder.
This ensures that all files (including invisible files) are processed together. We also recommend that you set the time
interval to check for jobs to 10 seconds or more to ensure that all files are in place before processing begins.

Submit a job to a Hot Folder

You can send a job to a Fiery server through a Hot Folder or from the desktop.
• Do one of the following.

• In the Fiery Hot Folders Console, select the Hot Folder and click Download Files on the taskbar. Then browse to
the file you want to download, or type the name of the file, and click Select.

• Drag and drop or copy and paste the file to a Hot Folder.
When you drag a file onto a Hot Folder that resides on the same disk partition, the file is moved, not copied,
because it is on the same partition. When you drag a file onto a Hot Folder that is on a separate partition or
drive, the file is copied, not moved.

• Print to a file from a document’s original application and specify the Hot Folder as the target destination.

Submit multiple jobs as a folder

With certain file formats (JPEG, PDF, or TIFF), you can submit multiple files that are inside an ordinary folder to a
Hot Folder.

Note: If Merge all files if submitted as a folder is selected in the Output file type setting for the particular input
format (JPEG, PDF, or TIFF), the individual files are merged into a single PDF file. Only files of the same type (e.g.,
all JPEG or all PDF) can be merged into a single file.
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• Submit a folder to the Hot Folder in one of the following ways:

• Drag and drop the folder onto the Hot Folder.

• Copy and paste the folder into a Hot Folder.

• Right-click the folder, choose Download to Hot Folder, and then choose the Hot Folder name (Windows only).

Submit multi-part jobs in a folder

Certain file formats consist of multiple files, some of which are not visible and which contain header and other
information. A multi-part job requires all these files when you submit the job.

Note: We recommend that you set the time interval to check for jobs to 10 seconds or more to ensure that all files
are in place before processing begins (see Advanced Settings under Create a new Hot Folder on page 6).

• When using a Hot Folder to process multi-part jobs, submit all of the files for the job within a folder to ensure
that all required files are processed together.

View Status & Log windows

The Fiery Hot Folders Console shows the progress of current jobs and a log of completed jobs.

• The Status window shows the progress of files being processed through a Hot Folder.

• The Log window shows a complete log of all processed jobs.

When processing is complete, the file is transferred to a supporting folder and the job appears in the Log window.

View Hot Folder job progress

The Status window shows the progress of files being processed through a Hot Folder.
1 In the Fiery Hot Folders Console, click Status & Log.

2 Click the Status tab.

3 Click one of the following in the Show for menu:

• Click All Servers to view the status for all Hot Folders.

• Choose a particular Fiery server to view status for that Fiery server.
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View Hot Folder logs

The Log window shows a complete log of all processed jobs.
1 In the Fiery Hot Folders Console, click Status & Log.

2 Click the Log tab.

3 Do one of the following:

• To view the log for all Hot Folders, choose All Hot Folders from the Show for menu.

• To view the log for a particular Hot Folder, choose the folder from the Show for menu.

• To view all jobs, click Complete Log.

• To view only jobs that failed to process or print, click Error Log.

View Hot Folder error details

You can view error details and other relevant information at the bottom of the Log window.
If a job fails to process, an alert indicator appears next to the job name.

1 In the Fiery Hot Folders Console, click Status & Log and then click the Log tab.

2 Select the failed job in the Log window.

Clear the Log window

You can clear the Log window if it is too full.
1 Click the Status & Log icon and click the Log tab.

2 Click Clear All.

3 Click Yes when prompted.
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Job Properties

Job Properties are the print options that you can specify for a job. The settings apply to the jobs submitted to the Hot
Folder.
These properties can include basic options such as duplex, stapling, or printing on a designated media, and advanced
settings, such as color profiles.

• If you choose Default for Job Properties, jobs use the default settings of the Fiery server.

• If you choose a preset, jobs use the preset settings.

• If Preserve Document Setting is set for some print options, printing uses the properties that are already set in the
job. You can override these settings.

Job Properties provides access to the advanced imposition features of your Fiery server. These include:

• Fiery Impose

• Booklet Maker, which includes the booklet and advanced finishing options available on your printer.

Job Properties groups

The Job Properties print options are grouped by categories for quick access.
The groups or tabs are as follows:

• Quick Access - Includes shortcuts to print options. You can customize this window to include frequently used
options or combinations of print options.

• Job Info - Includes information about the job, including user information required for user authentication,
secure print properties, and job handling.

• Media - Includes media attributes and sources of paper.

• Layout - Includes options about how the file is positioned or imaged on the media/sheet, except for positioning
that compensates for finishing options, for example, Tray Alignment. Layout includes access to Fiery Impose
software, if available for your Fiery server.

• Color - Includes print options available on color printers.

• Image - Includes image transformation quality settings, except for settings that control color.

• Finishing - Includes print options related to finishing equipment on the printer and also image shifting to
compensate for finishing options.

• VDP - Includes print options related to variable data printing.

• Stamping - Includes image stamping options that add, hide, or remove any image on the job. This also includes
watermark properties. The Stamping tab may not be supported for all Fiery servers.

• Summary - Provides a summary of the Job Properties.
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Specify Hot Folder Job Properties

You can specify the Job Properties for a Hot Folder from the Fiery Hot Folders Console.
1 In the Fiery Hot Folders Console, double-click the Hot Folder to open the Hot Folder Settings window.

2 Click Define in the Job properties menu to open the Job Properties window.

Note: By default, you might see that Preserve Document Setting is set for some print options. This setting lets
you maintain properties that are already set in the job. You can override these settings. The settings are applied to
the jobs submitted to the Hot Folder. If you choose Default for Job Properties, jobs are printed with the default
settings of the Fiery server. If you choose a preset, jobs are printed with the preset settings. For more
information, see Using presets on page 16.

3 Specify print options in each group or choose a preset from the Presets list.

Using presets

Presets are available from Job Properties. The job presets can be found in the Presets list with the names of saved
presets, and options such as Save Preset, Manage Local Presets, Default, and Server Presets.
You can select one of the job presets from the list, or create a new preset based upon the current options selected in
the Job Properties window. If a job is not currently using a preset, then the preset setting will be blank; no text
appears in the Presets setting. All properties display the initial default settings. When a job preset is selected, all
settings are updated to reflect the saved preset. If you change any print settings, the Presets list reverts to blank.
There are two types of job presets:

• Local Presets are saved on the user’s local computer, and not shared with other users. Local Presets are available
any time you access the Job Properties window. They remain on your local hard disk until you delete them.

• Server Presets are saved on the Fiery server and shared with other users of the Fiery server.
When a server preset is selected for a Hot Folder, the job properties displayed in the Fiery Hot Folders Console
shows the preset name and corresponding settings. For server presets, the Refresh button updates the display
with the current settings on the Fiery server. You can also enable Hot Folders to update its display of a server
preset’s settings automatically at a specific time interval. For more information, see Set Hot Folders preferences
on page 9.

In Command WorkStation, if you are logged on to the Fiery server as the administrator, you can create, edit, rename,
unpublish, publish, and delete a Server Preset. In Hot Folders, you can save a Local Preset in the Job Properties
window only.

Create a Local Preset

You can create a Local Preset by choosing the settings in the Job Properties window and then saving them in the
Presets list. Server Presets and Local Presets are listed separately and differentiated by separator lines in the Presets
list.

1 In the Fiery Hot Folders Console, double-click the Hot Folder to open the Hot Folder Settings window.
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2 Click Define in the Job properties menu to open the Job Properties window.

3 Adjust the print settings for each tab as desired.

4 Under Presets, click Save Preset.

5 Select Local Presets.

6 Enter a descriptive name for the preset and click Save.

The preset is added to the list of available presets. Local Presets are available any time you access the Job Properties
window. They remain on your local hard disk until you delete them.

Edit a Local Preset

You can edit a local preset.
1 In the Fiery Hot Folders Console, double-click the Hot Folder to open the Hot Folder Settings window.

2 Choose Define in the Job properties menu to open the Job Properties window.

3 Under Presets, choose Manage Local Presets.

4 Select the preset you want to edit.

5 Change the print settings. (The Presets field becomes blank.)

6 Choose Save Preset from the Presets list.

7 Type the same preset name, and then click Save to save the preset.

8 Click OK to replace the current preset of the same name.

Delete and rename a local preset

You can delete or rename presets.
1 In the Fiery Hot Folders Console, double-click the Hot Folder to open the Hot Folder Settings window.

2 Click Define in the Job properties menu to open the Job Properties window.

3 Under Presets, choose Manage Local Presets.

4 Select the preset and do one of the following:

• To delete the preset, click Delete.

• To rename the preset, click Rename, enter a descriptive name for the preset, and click Save.
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Create a server preset

Administrators can save settings in the Job Properties window as server presets. These presets are saved on the Fiery
server and shared with its users.
1 Click Server > Device Center > Workflows > Job Presets.

2 Click New.

3 Enter a descriptive name for the preset.
Spaces are not allowed in preset names.

4 Enter a description for the preset (optional).

5 Choose the type of server preset by selecting one of the following:

• Complete - The preset contains all the settings in Job Properties. When you apply this type of preset, it will
override all current job settings.

• Selective - The preset contains only Job Properties settings that you select. When you apply this type of preset,
it will change only the defined settings. All other job settings are preserved.

You cannot create a virtual printer from this preset if you choose Selective.

6 Click Define to specify the job properties, and then click OK.

7 Click OK to close the Job Preset Settings window.

The Server Presets are available any time you access Server > Device Center > Workflows > Job Presets or the Job
Properties window. They remain on the Fiery server until an Administrator deletes them.
After a Server Preset is created, the Settings pane (located on the right side) shows the settings modified from the
defaults, and locked settings. The Server Preset is published automatically so it can be shared with other users
connected to the Fiery server.
Selective presets can be created only in Device Center. They cannot be created from Job Center.

About selective presets

Because you can select only some job properties when you create a selective preset, you can use more than one
preset with a hot folder. For example, you can create Preset #1 with only finishing settings, and Preset #2 with only
media settings. As long as the selective presets do not contain settings that conflict with one another, you can use
more than one at a time.
If you apply more than one selective preset to a hot folder and then edit any of the presets except the one most
recently applied, then the hot folder does not reflect the changed properties. If the most recently applied preset is
modified, the job retains only the recently applied preset attributes. The other selective presets are disregarded.

About locked server presets

You can lock or unlock a server preset’s print settings in Server > Device Center > Workflows > Job Presets.
You must be logged on to Fiery server as Administrator to perform these operations.
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Locking a setting in a Server Preset ensures that:

• It is applied to all files imported to Command WorkStation using the preset.

• It can be overridden in the printer driver job properties after it is selected, but when it is overridden, the Preset
list becomes blank.

• Fiery Hot Folders jobs also inherit the same locked settings (assuming the Fiery Hot Folders uses the Server
Preset).

• Virtual printers show the settings as locked. Client printer drivers connected to a virtual printer are unable to
modify the setting.

You cannot lock Output profile because the Fiery server always defaults to Use job defined settings.
Locks apply only at the time of job submission. After the jobs are at the Fiery server, any locked setting can be edited
in the Job Properties window of Command WorkStation.

Lock or unlock settings in Server Presets

You must be logged on to Fiery server as Administrator to lock or unlock print settings in Server > Device Center >
Workflows > Job Presets.

1 Select the preset you want to edit, and click Edit from the toolbar.

2 Enter a description for the change (optional).

3 Click Define to change the print settings.

4 Do one of the following:

• Click Lock All to lock all the print settings.

• Click the lock icon to lock a specific print setting.

• Click Unlock All to unlock all the print settings.

• Click the lock icon to change it to the unlock icon for a specific print setting.

5 Click OK.

Edit, delete or unpublish Server Presets

You can edit, delete, or unpublish a server preset in Server > Device Center > Workflows > Job Presets.
You must be logged on to the Fiery server as Administrator to perform these operations.
If you edit or delete a Server Preset that is currently being used, the changes will affect only future jobs. The changed
preset settings are applied instantly to any Fiery Hot Folders or virtual printers using the specified Server Preset.
You can overwrite an existing Server Preset the same way you can overwrite files on a computer. A Server Preset can
be overwritten from Job Properties.
Jobs already in the Held or Printed queue of the Fiery server do not automatically reflect edits made to the preset. If
you want to update any jobs in the queues of the Fiery server with a newly edited preset, you need to re-apply the
preset to the job using Job Properties.

Fiery Hot Folders

Fiery Hot Folders

19



Edit Server Presets

Administrators can edit server presets. You can edit Server Presets from within Command WorkStation (Server >
Device Center > Workflows) or within Job Properties.
1 To edit a preset from Device Center, select the preset you want to edit, and click Edit from the toolbar in Device

Center > Workflows > Job Presets.
a) Enter a description for the change (optional).

b) Click Define to change the print settings.

c) Click OK.

2 To edit a preset from Job Properties, right-click a job in the Held or Printed queue, and select Job Properties.
a) Select a server preset from the Presets list for the job.

b) Make any changes to Job Properties, which you wish to apply to the preset.

c) In the Presets list, select Save Preset, select Server Preset, and type the exact name for the preset.

d) Click Save, and then click OK to overwrite the existing preset.

Delete Server Presets

Administrators can delete Server Presets.
1 Select one or more presets (unpublished or published) from the list.

To select multiple presets, use shift-click, ctrl-click (Windows), or cmd-click (macOS). To select all presets, press
ctrl+A (Windows) or cmd+A (macOS).

2 Click Delete on the toolbar.

3 Click Yes.
Any Fiery Hot Folders and virtual printers linked to the deleted preset will be disconnected. However, they will
preserve the settings of the deleted preset.

Unpublish Server Presets

An unpublished preset is not available for use in the printer drivers or the Job Properties window. After you
unpublish a Server Preset, you can publish it again.
1 Select one or more presets with the published icon from the list.

To select multiple presets, use shift-click, ctrl-click (Windows), or cmd-click (macOS). To select all presets, press
ctrl+A (Windows) or cmd+A (macOS).

2 Click Unpublish on the toolbar.
The preset is shown with the unpublished icon.
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3 Click Yes.
Any Fiery Hot Folders and virtual printers linked to the unpublished preset will be disconnected. However, they
will preserve the settings of the unpublished preset.

Export and import Server Presets

You can export Server Presets to a file (Exported Presets.fjp) from one Fiery server, and then import the file on
another Fiery server of the same model and version in Server > Device Center > Workflows > Job Presets.
You can also export Server Presets for safekeeping by using the Backup & Restore tool (Server > Device Center >
General > Tools). Preset Backup files cannot be restored to a different model Fiery server.
When importing a presets file, the new presets can be merged with existing ones, or can replace existing presets.
You must be logged on to the Fiery server as Administrator to export and import Server Presets.

Export Server Presets

Administrators can export Server Presets for use on another Fiery server.
1 Click Export from the toolbar.

2 Browse to a location to save the Exported Presets.fjp file.

3 Click Save.

Import Server Presets

After exporting Server Presets from one Fiery server, Administrators can import them for use on another similar
Fiery server.
1 Click Import from the toolbar.

2 Choose Merge with existing or Replace existing.
If the Server Presets are merged, the presets in the imported file are added to the existing presets on the Fiery
server. If there are any duplicate names, the imported presets will have a numeric suffix appended to the end of
the preset name, such as FirstTest-1.
If the Server Presets are replacing existing presets, all the current Server Presets are deleted and replaced with the
Server Presets contained in the newly imported Fiery Job Preset file.

3 Browse to the location of the Exported Presets.fjp file.

4 Click Open.
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Imposition templates

You can apply imposition layouts for special printing and binding needs. To impose a layout, you apply an
imposition template to a Hot Folder, and then drag the job to that Hot Folder.
Default imposition templates are accessible without a license or dongle. Custom imposition templates require a
license (or a dongle if you are connected to a Fiery server that requires one).

• To create a custom template, change the imposition settings of an existing template and save the new template to
the Hot Folder.
The Based on Crop Box finish size setting is used for the default imposition templates. The User Defined and
Based on Trim Box finish size settings are supported for custom imposition templates. User Defined uses the PDF
trim box defined in the source document as the finish size.The user can override the default value to set the trim
size. Based on Trim Box is available for gangup imposition only. The Based on Trim Box workflow is an automated
workflow that dynamically creates the layout for different smaller-sized items (such as business cards, postcards,
or concert tickets) on a larger-sized sheet (such as 11 x 17).

Note: User Defined and Based on Trim Box custom templates require PDF source files. PostScript files are not
supported.

If your Hot Folder is connected to a Fiery server that supports variable data printing, you can also impose variable
data printing jobs.

Edit imposition templates

Fiery Impose lets you edit imposition templates. The Fiery server must support Fiery Impose, and you must have the
appropriate license. Some older Fiery servers may require a dongle.
1 In the Fiery Hot Folders Console, double-click the Hot Folder to open the Hot Folder Settings window.

2 Click Define in the Job properties menu to open the Job Properties window.

3 Choose Layout > Impose.

4 Do one of the following:

• Choose an imposition template from the list and click OK.
The Based on Crop Box finish size setting is used for the default imposition templates.

• Click Edit Impose Template to start Fiery Impose and create a custom template.
The User Defined finish size setting is supported for custom imposition templates and supports the Acrobat
PDF trim box setting.

• The Based on Trim Box finish size setting is supported for gangup custom imposition templates and supports
the Acrobat PDF trim box setting.

Note: User Defined and Based on Trim Box custom templates require PDF source files. PostScript files are not
supported.
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Predefined imposition templates

Hot Folders offers several imposition templates: 1-up full bleed, 2-up perfect, 2-up saddle, 3-up trifold brochure, 4-
up gate fold, 4-up head to head, and 4-up z-fold.

1-up full bleed

The 1-up full bleed layout lets you print one page per sheet. The printer’s marks indicate where to cut the paper so
that the color content extends to the edge of the paper. This layout has no page number restrictions. It applies the
following settings:

• Bleeds

• Printer’s Marks (trim marks and job label only)

• Scale to Fit

• Gangup Unique

2-up perfect

The 2-up perfect layout lets you create signatures for a perfect-bound book. Each sheet is folded once and stacked on
top of one another.
The 2-up perfect layout is for jobs that have multiples of four pages, but you can use it with jobs that have any
number of pages. Additional blank pages are added if necessary. Pages are ordered in groups of four so that, when
folded, each sheet has four sequential pages. The Creep Adjustment option has no effect on this template.
The 2-up perfect layout applies the following settings:

• Duplex

• Bleeds

• Printer’s Marks (fold marks, trim marks, and job label)

• Scale to Fit

• Perfect Binding

2-up saddle

The 2-up saddle layout lets you create sheets for a saddle-bound book. All of the sheets are folded together, one
inside the other.
The 2-up saddle layout is for jobs that have multiples of four pages, but you can use it with jobs that have any
number of pages. Additional blank pages are added if necessary. Pages are ordered so that, when sheets are folded
and stitched together, the pages are sequential.
The 2-up saddle layout applies the following settings:

• Duplex

• Bleeds

• Printer’s Marks (fold marks, trim marks, and job label)

• Scale to Fit

• Saddle Binding
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3-up trifold brochure

The 3-up trifold brochure layout is for jobs that have six pages or multiples of six pages, but you can use it with jobs
that have any number of pages. Additional blank pages are added if necessary.
The 3-up trifold brochure layout consists of a single sheet folded into three sections. Although the three sections are
the same width, the space between each section varies so that the leftmost panel can be folded over the other two
panels.
The 3-up trifold brochure is usually folded as shown in the following illustration.

The 3-up trifold brochure layout applies the following settings:

• Duplex

• Printer’s Marks (fold marks, trim marks, and job label only)

• Scale to Fit

• Gangup Unique

4-up gate fold

The 4-up gate fold layout is used most often in the case of a four-panel brochure. The finished brochure unfolds to
double, then four times the original size.
The 4-up gate fold layout should be used with jobs that have eight pages or multiples of eight pages, but it can be
used with jobs that have any number of pages. Additional blank pages are added if necessary.
The 4-up gate fold is usually folded as shown in the following illustration.

The 4-up gate fold layout applies the following settings:

• Duplex

• Bleeds

• Printer’s Marks (fold marks, trim marks, and job label only)

• Scale to Fit

• Gangup Unique

4-up head to head

The 4-up head to head layout lets you create booklets from a layout of four pages on each side of the printed sheet.
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The 4-up head to head layout is for jobs that have multiples of eight pages, but it can be used with jobs that have any
number of pages. Additional blank pages are added if necessary. Pages are ordered so that when sheets are folded
with two folds at 90 degrees, trimmed, and stitched together into signatures, the pages are sequential. By rotating the
two topmost pages, the signature can be folded both horizontally and vertically, and trimmed. The finished booklet
has all pages in the correct order and rotation.
Note that although this layout requires two folds, the template applies fold marks on the spine fold only.
The 4-up head to head is usually folded as shown in the following illustration.

The 4-up head to head layout applies the following settings:

• Duplex

• Bleeds

• Gutters

• Printer’s Marks (fold marks, trim marks, and job label)

• Scale to Fit

• Saddle Binding

4-up z-fold

The 4-up z-fold layout allows many panels to be folded on top of one another without stressing the folded spine. The
most common example is a road map.
This layout should be used for jobs that have eight pages, but it can be used with jobs that have any number of pages.
Additional blank pages are added if necessary. The 4-up z-fold is usually folded as shown in the following illustration.

The 4-up z-fold layout applies the following settings:

• Duplex

• Printer’s Marks (fold marks, trim marks, and job label only)

• Scale to Fit

• Gangup Unique
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Hot Folder input formats

The Input formats window provides access to file filters and application-specific options.
File filters convert most file types to PostScript or PDF before sending the file to the Fiery server. Application-
specific options allow you to modify print setup options (such as custom or automatic scaling, orientation, and
resolution) without opening or installing the original application.
Once you assign a filter, the Hot Folders application automatically detects the file type and converts the file to
PostScript or PDF before sending it to the Fiery server.

Output file type

Most of the Hot Folders filters convert to PostScript by default. The Output file type option lets you further convert
PostScript to PDF, if necessary.
When you convert Microsoft Office files, the Hot Folders application can retrieve Distiller profiles from the default
location defined in Adobe Acrobat. However, if you have saved your profiles in a different location, you will need to
manually copy the default location.
For PDF, TIFF, and JPEG files, you have the option to Merge all files if submitted as a folder.
The Output file type option is available for all filters except VDP.

Specify input formats

You can specify input formats from the Hot Folder Settings window.
1 In the Fiery Hot Folders Console, double-click the Hot Folder to open the Hot Folder Settings window.

2 Click Edit next to Input formats to open the Input formats window.

3 Select one or more input formats (filters) on the left side of the window.

4 Configure the details for the input format on the right side of the window.

5 To set output file type, click the file type in the Output file type pane.

6 Click OK to return to the Hot Folder Settings window.

7 Click OK to save the settings.

Hot Folders filters

Hot Folders filters convert files to PostScript or PDF before sending the file to the Fiery server.
The filters are grouped in these categories:

• General filters (for most graphic arts and production printing applications)

• Microsoft filters
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• JDF Filter

• Passthrough filter

Most of the filters are non-exclusive: You can apply as many filters as you want to the same Hot Folder, provided the
filters fall within the same category. However, you cannot apply filters from different categories to the same Hot
Folder.
In some cases, not all filters are available. The available filters depend on the options that are installed on the Fiery
server that a Hot Folder is connected to.

General filters

General filters include filters for most graphic arts and production printing applications.

EPS filter

The EPS filter converts EPS files and provides options for custom or automatic scaling, orientation, and positioning
the image on the page.
The EPS filter input file type is .eps.

Option Description

Original Size Preserves the size of the original image.

Custom Size Scales the image to the values you enter for width and height.

Constrain Proportions Maintains the original aspect ratio, so that images are not stretched or
distorted. When selected, you enter only one value (either height or width) and
the other value is automatically defined to preserve the proportions of the
original image.

Auto-scale: Fit to page Resizes the image (by scaling up or down) to automatically fit the page size you
specify.

The image is scaled in relation to the page size you select for the Size setting
under Page. If you selected a different page size in Job Properties (Media tab),
the image is still scaled in relation to the Size specified in Input Formats, but
the job is printed on the paper size specified in Job Properties.

Auto-scale: Shrink to fit Shrinks the image (by scaling down) to automatically fit the page size you
specify.

Shrink to fit only scales down. If the image is already smaller than the page size,
no scaling occurs.

The image is scaled in relation to the page size you select for the Size setting
under Page. If you selected a different page size in Job Properties (Media tab),
the image is still scaled in relation to the Size setting, but the job is printed on
the paper size specified in Job Properties.
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Option Description

Scale to printable area only Ensures that no cropping occurs when using Auto-scale: Fit to page and Auto-
scale: Shrink to fit.

If you want a full bleed, do not select this option.

Size Specifies the page size for Auto-scale: Fit to page and Auto-scale: Shrink to fit.

Orientation Specifies Portrait or Landscape orientation.

Select Auto-rotate image to allow automatic rotation that best fits the image to
the selected orientation.

Image Position Positions the image on the page in relation to Top-Left, Top-Right, Bottom-
Left, Bottom-Right, or Center, which is the default.

Output file type See Output file type on page 26.

JPEG filter

The JPEG filter converts most standard JPEG files to PostScript or PDF files and provides options for custom and
automatic scaling, resolution, orientation, and positioning the image on the page.
You input .jpeg, .jpg files for the JPEG filter. You can submit multiple JPEG files in a folder, which are then merged
together and output as a single PDF file. To activate this feature, select the option to Merge all files if submitted as a
folder under Output file type.

Option Description

Original size Preserves the size of the original image.

Custom size Scales the image to the values you enter for width and height.

Constrain Proportions Maintains the original aspect ratio, so that images are not stretched or
distorted. When selected, you enter only one value (either height or width) and
the other value is automatically defined to preserve the proportions of the
original image.

Resolution Scales image to print at the resolution you specify.

The maximum resolution depends on your print device.
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Option Description

Auto-scale: Fit to page Resizes the image to automatically fit the page size you specify in Input
Formats.

The image is scaled in relation to the page size you select for the Size setting
under Page. If you selected a different page size in Job Properties (Media tab),
the image is still scaled in relation to the Size specified in Input Formats, but
the job is printed on the paper size specified in Job Properties.

Auto-scale: Shrink to fit Shrinks the image (by scaling down) to automatically fit the selected page size.

Shrink to fit only scales down. If the image is already smaller than the page size,
no scaling occurs.

The image is scaled in relation to the page size you select for the Size setting
under Page. If you selected a different page size in Job Properties (Media tab),
the image is still scaled in relation to the Size specified in Input Formats, but
the job is printed on the paper size specified in Job Properties.

Scale to printable area only Ensures that no cropping occurs when using Auto-scale: Fit to page and Auto-
scale: Shrink to fit.

The printable area is determined by your print device.

Size Specifies the page size for Auto-scale: Fit to page and Auto-scale: Shrink to fit.

Orientation Specifies Portrait or Landscape orientation.

Select Auto-rotate image to allow automatic rotation that best fits the image to
the selected orientation.

Image Position Positions the image on the page in relation to Top-Left, Top-Right, Bottom-
Left, Bottom-Right, or Center, which is the default.

Output file type See Output file type on page 26.

FreeForm Plus filter

The FreeForm Plus filter accepts files created from the FreeForm Create application (file extension.ffp) for a Fiery
server that uses FS400 software or later.

PDF filter

PDF/X (PDF Exchange) Preflight is a subset of Adobe PDF designed specifically for prepress data interchange. It
defines how applications that read and create PDF/X files should behave.
The PDF filter verifies that a PDF file is compliant with either the PDF/X-1a or PDF/X3 standard. The filter checks
whether your PDF files comply with these standards. If a PDF file is not PDF/X-compliant, the job fails to process
and an error report appears.
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The PDF filter is used exclusively for the preflight feature.
The PDF filter input file type is PDF.

Note: You can submit multiple PDF files in a folder, which are then merged together and output as a single PDF file.
To activate this feature, select Merge all files if submitted as a folder under Output File Type.

Option Description

PDF Passthrough This option allows PDF files to be submitted to the server untouched, and
can be used for nonstandard PDF files generated by 3rd party applications.

PDF (VT) PDF/VT (Portable Document Format/Variable Transactional) is an Adobe
created variable data file format. When PDF (VT) is selected, all other PDF
options except for the Output file type of PDF are disabled.

The PDF/VT checkbox appears only when the Hot Folder is connected to a
Fiery server that supports PDF/VT.

If the Fiery server supports PDF/VT, you can specify PDF/VT as the input
format by selecting PDF in the General list in the Input Formats dialog box,
and then selecting PDF/VT in the PDF pane.

PDF/X preflight Specifies which PDF/X standard to preflight against.

PDF/X1-a standard: Address blind exchanges to verify that files contain only
CMYK (and/or spot colors), with no RGB or device-independent (color-
managed) data.

PDF/X3: Meets all the requirements of the PDF/X-1a standard, but contains
device-independent (color-managed) data.

For more information about preflight and PDF/X compliance, see the
documentation that accompanies your Fiery server.

Error report Saves an error report to the location you specify.

Click Browse to select the location where you want to save error reports.

Output file type See Output file type on page 26.

PS filter

The PS (PostScript) filter is used exclusively to specify the Output file type. Since the file type is already PostScript,
no conversion takes place when using this filter.
The PS filter input file type is .ps

Option Description

Output file type See Output file type on page 26.
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TIFF filter

The TIFF filter converts TIFF (Tagged Image File Format) files to PostScript or PDF files and provides options for
custom or automatic scaling, resolution, orientation, and position of the image on the page.
The TIFF filter input file type is .tiff, .tif.
You can submit multiple TIFF files in a folder, which are then merged together and output as a single PDF file. To
activate this feature, select Merge all files if submitted as a folder under Output File Type.

Option Description

Original size Preserves the size of the original image.

Custom size Scales the image to the values you enter for width and height.

Constrain Proportions Maintains the original aspect ratio, so that images are not stretched or
distorted. When selected, you enter only one value (either height or width) and
the other value is automatically defined to preserve the proportions of the
original image.

Resolution Scales the image to print at the resolution you specify.

The maximum resolution depends on your print device.

Auto-scale: Fit to page Resizes the image (by scaling up or down) to automatically fit the page size you
specify in Input Formats.

The image is scaled in relation to the page size you select from the Input Format
> Size menu. If you selected a different page size in Job Properties (Media tab),
the image is still scaled in relation to the Size specified in Input Formats, but
the job is printed on the paper size specified in Job Properties.

Auto-scale: Shrink to fit Shrinks the image (by scaling down) to automatically fit the selected page size
you specify in Input Formats.

Shrink to fit only scales down. If the image is already smaller than the page size,
no scaling occurs.

The image is scaled in relation to the page size you select for the Size setting
under Page. If you selected a different page size in Job Properties (Media tab),
the image is still scaled in relation to the Size specified in Input Formats, but
the job is printed on the paper size specified in Job Properties.

Scale to printable area only Ensures that no cropping occurs when using Auto-scale: Fit to page and Auto-
scale: Shrink to fit.

The printable area is determined by your print device.

Size Specifies the page size for Auto-scale: Fit to page and Auto-scale: Shrink to fit.
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Option Description

Orientation Specifies Portrait or Landscape orientation.

Select Auto-rotate image to allow automatic rotation that best fits the image to
the selected orientation.

Image Position Positions the image on the page in relation to Top-Left, Top-Right, Bottom-
Left, Bottom-Right, or Center, which is the default.

Output file type See Output file type on page 26.

VDP filter

The VDP filter processes VDP (Variable Data Printing) jobs, which are sent directly to the Fiery server.
The input file types for the VDP filter are .ppml, .zip, .vps, .ps.
Associated VIPP files must be present in XGFC folders.

Microsoft filters

The Microsoft Office filter is an exclusive filter and cannot be selected at the same time as other input folders. The
Microsoft filters convert Microsoft native file formats (files created in Microsoft Office applications, such as Excel,
PowerPoint, Word, and Publisher) to PostScript or PDF.
These filters require Microsoft Office to be installed on the same system as the Hot Folders application you are using.
You must also have a PostScript printer or Acrobat Distiller installed on your system.
To process Microsoft Office files in Hot Folders, you must be logged in. If a hot folder was configured for Microsoft
Office formats and other formats before Hot Folders 4.0, Hot Folders will create a copy of the folder that only accepts
the Microsoft Office format.
The exclusive Microsoft Office format folder has "_Office" at the end of its name.
Microsoft filters are not supported on Mac OS.
The following versions and file formats are supported:

Application Version File extensions

Office 2003, 2007, 2010, 2013, 2016, Office 365 Various

Word 2003, 2007, 2010, 2013, 2016, Office 365 .doc, .docx

Excel 2003, 2007, 2010, 2013, 2016, Office 365 .xls, .xlsx

PowerPoint 2003, 2007, 2010, 2013, 2016, Office 365 .ppt, .pps, .pptx, .ppsx
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Application Version File extensions

Publisher 2003, 2007, 2010, 2013, 2016, Office 365 .pub

Note: To print Office 2007 files, you must have the Office 2007 application installed on your system. Office 2007 is
compatible with Office 2003 and Office 2000, but earlier versions of Microsoft Office cannot process Office 2007
files.

Note: For output to PDF, clear the option Rely on system fonts only; do not use document fonts in Adobe PDF
printing preferences.
The Microsoft filters have these settings and options:

Settings and Options Description

Printer Name Selects a PostScript printer driver installed on your Windows system.

The filter uses the driver to create a PostScript file, which is then sent to the
Fiery server from the Hot Folder.

PowerPoint settings:

Print Selects output format for Slides, Handouts, Notes Pages, or Outline view.

Color/grayscale Selects output for Color, Grayscale, or Pure Black and White.

Advanced print options:

Scale to fit paper Scales the image to automatically fit the paper size specified in your
application.

Frame slides Prints a frame around each slide.

Print comments and ink markup Prints document with comments, annotations, and any ink drawing or
markups.

Print hidden slides Prints the slides that are hidden.

High quality Prints transparent images, graphics and fills with higher quality (which may
change colors slightly, and softens shadow effects by printing in higher
resolution.

Selecting High quality can greatly increase the size of your PostScript file
(by as much as 250%), which may result in slower processing time through a
Hot Folder and at the Fiery server.

The High Quality setting is available only if PowerPoint 2007 is installed on
your computer.
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Settings and Options Description

Output file type See Output file type on page 26.

JDF Filter

Hot Folders supports the JDF (Job Definition Format) workflow. JDF technology is an XML-based open industry
standard for job tickets.
JDF jobs from a submitting application can be submitted through Hot Folders to Fiery servers that have JDF
submission enabled. The JDF filter is supported on Windows Hot Folders only, not on Mac OS Hot Folders.
When you submit a JDF job to a Hot Folder, the Input formats dialog box displays the JDF option and disables all
other options. The JDF filter requires a Fiery server that supports JDF jobs and has the Fiery JDF feature turned on in
Configure.
Setting JDF as an input format disables the job properties and job action selections in Hot Folders. The job uses
settings defined in the JDF ticket of the job and any JDF settings configured on the Fiery server. You can specify the
job action for JDF jobs by choosing a Virtual Printer in the JDF section of Configure.
When you submit a JDF job to a Hot Folder, the job goes through the standard JDF workflow on the Fiery server and
is managed through Command WorkStation.
You can specify JDF as the input format by selecting JDF in the Input formats dialog box.

Passthrough filter

The Passthrough filter allows you to drop files into the Hot Folder without applying Job Properties or converting any
file formats.
The result of using the Passthrough filter is the same as if you had imported the file using the File > Import action in
Command WorkStation.

Note: When you process an unsupported file format with the Passthrough filter, the job will be moved to the Printed
queue with an error.

Preflight

Preflight checks jobs submitted to the Hot Folder in the most common areas of error, thus reducing costly printing
errors.
To perform a preflight check, you will require one of the following:

• Fiery Graphic Arts Package, Premium Edition (FS350 Pro and earlier)

• Fiery Graphic Arts Pro Package (FS400 Pro)

• Fiery Automation Package (FS400 and later)

If the Hot Folder has Direct connection specified as the Job Action, Preflight is not available.
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Preflight performs a specified action based on settings you configure for a Hot Folder with Preflight enabled.
Preflight checks for the following errors:

• Fonts - Checks for missing fonts and Courier font substitution.

• Spot Colors - Checks for missing spot colors. (You can add missing spot colors in Command WorkStation Spot
Colors.)

• Image Resolution - Checks for image resolution less than a specified value.

• VDP Resources - Checks for missing VDP resources.
You can choose to check a specific number of records. Select this option to avoid a potentially long processing
time for Preflight.

• Hairlines - Checks for line thickness less than a specified value.

• Overprint - Checks for overprint.

The following file formats are supported for Preflight:

Fiery server Supported file formats

Windows-based PostScript, PDF, EPS, PPML, Creo VPS, and PDF/VT

Embedded PostScript, PDF, EPS, and Creo VPS

TIFF and PCL file formats are not supported for Preflight.

Set Preflight Settings

You can set preflight settings to check every job that is submitted to the Hot Folder for errors.
1 In the Fiery Hot Folders Console, double-click the Hot Folder to open the Hot Folder Settings window.

2 Do one of the following:

• Select Preflight and click Edit to open the Preflight Settings window.

• Or choose a preset from the Preset menu to automatically select the combination of settings saved in the
preset. If the preset contains all the settings you want, skip to step 6 on page 35.

3 Specify which errors you want to check for, and set the notification level (Critical or Warning) for that error.

4 If you want Preflight to stop checking for errors when it detects the first critical error, select Stop preflight on first
critical error.

5 If you want to use the settings again, choose Save or Save As from the Preset list. To delete a preset, select it and
choose Delete from the Preset list.

6 Click OK to return to the Hot Folder Settings window.
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7 From the On critical error menu, choose an action that Hot Folders performs if it detects at least one critical error.
Click one of the following:

• Hold - Sends a job to the Hold queue, where it is spooled to the Fiery server hard disk and held in the queue for
printing at a later time.

• Process and Hold - Processes a job and then places the processed job in the Hold queue for printing at a later
time.

• Proof Print - Processes and prints one copy of a job. This action is useful for checking the job output before
printing the number of copies called for in the job.

• Use job action - Performs the job action configured in the Hot Folders settings.

8 Click OK to save the settings.

Fiery Preflight Pro

You can use the Fiery Preflight Pro feature to check PDF and PDF/VT jobs. Preflight Pro checks PDF and PDF/VT
jobs to verify that it conforms to a set of standards defined in a selected preset.
Preflight Pro is available only on Windows-based Fiery servers with Fiery system software FS500 Pro or later.
Preflight Pro is enabled only if the Fiery Graphic Arts Pro Package is activated on the Fiery server.
The checks performed by Preflight Pro are based on the settings defined in a selected preset. Presets can be applied
to spooled, and processed jobs. Preflight Pro generates a report to capture the errors and warnings in PDF and
PDF/VT jobs, if the jobs deviate from the standards defined in the preset.
Preflight Pro generates a report to capture the errors and warnings in PDF and PDF/VT jobs, if the jobs deviate from
the standards defined in the preset.

Note: Preflight Pro is applicable only to PDF and PDF/VT jobs. Preflighting of all non-PDF file types is done using 
Preflight on page 34.
To access Preflight Pro, you must log in to Command WorkStation with Administrator or Operator access. Right-
click a spooled or processed PDF or PDF/VT job in Command WorkStation Job Center and select Preflight Pro. You
can also preflight jobs that are submitted from Fiery Hot Folders or virtual printers.

Set Preflight Pro settings for a Hot Folder

You can set Preflight Pro settings to check every job that is submitted to the Hot Folder for errors.
1 In the Fiery Hot Folders Console, double-click the Hot Folder to open the Hot Folder Settings window.

2 Select Preflight and do any of the following:

• For PDF or PDF/VT jobs, choose a preset from Preset for PDF output, and go to step 6.

• For non-PDF jobs:

• Click Edit to open the Preflight Settings window and set the required preflight settings.

• In the Preflight Settings window, choose a preset from the Preset menu to automatically select the
combination of settings saved in the preset. If the preset contains all the settings you want, skip to step 6.
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3 Specify which errors you want to check for, and set the notification level (Critical or Warning) for that error.

4 If you want Preflight Pro to stop checking for errors when it detects the first critical error, select Stop preflight on
first critical error.

5 If you want to use the settings again, choose Save or Save As from the Preset list. To delete a preset, select it and
choose Delete from the Preset list.

6 Click OK to return to the Hot Folder Settings window.

7 From the On critical error menu, choose an action that Hot Folders performs if it detects at least one critical error.
Click one of the following:

• Hold - Sends a job to the Hold queue, where it is spooled to the Fiery server hard disk and held in the queue for
printing at a later time.

• Process and Hold - Processes a job and then places the processed job in the Hold queue for printing at a later
time.

• Proof Print - Processes and prints one copy of a job. This action is useful for checking the job output before
printing the number of copies called for in the job.

• Use job action - Performs the job action configured in the Hot Folders settings.

8 Click OK to save the settings.

Add JobExpert to Fiery Hot Folders

You can apply JobExpert to new Hot Folders in Fiery Hot Folders.
You must connect to a Fiery server that supports Fiery JobExpert.

1 Open the Fiery Hot Folders Console.

2 Click New.

3 Choose from one of the following rules:

• All categories

• Color management

• Image quality

• VDP

4 Click OK.
When a job is imported through Fiery Hot Folders, JobExpert will apply the recommended settings.
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Backup and Restore

The Backup and Restore feature lets you create a backup of all the Hot Folders on your system and their settings.
Using Backup and Restore, you can:

• Create an individual backup, which you can use to restore your Hot Folders and their settings.

• Create a backup archive, which you can use to revert to the Hot Folders and their settings from a specific date.

• Copy your Hot Folders and their settings to another system or group of systems. (This is a quick way to set up
Hot Folders with identical settings for users working together or sharing Hot Folders on a network.)

The backup process creates copies of all your Hot Folders in a compressed (.fbf ) file that contains all the Hot Folders
on your system, saved with the following settings:

• Hot Folder settings (Folder name and Description)

• Network setting (Server Name and Job Action)

• Job Properties settings (any print or imposition settings configured for the Hot Folder)

• Input format settings (any filters and application-specific formats configured for the Hot Folder)

The backup maintains the Hot Folder status (Activated or Deactivated).
After you back up Hot Folders, you can restore the Hot Folders and their settings to your system or to another
system. In general, you want to restore your Hot Folders to the same location as the original, otherwise, the Hot
Folders application creates duplicate Hot Folders with the same name that appear in the Fiery Hot Folders Console.

If you created a backup using the Backup and Restore feature, you can use the backup to restore a
deleted Hot Folder that was included in the backup, but not the original files of submitted jobs.

Backup of original files

The Backup does not include the original files inside the Hot Folders supporting folders. By default, this is where
original files are archived.
If you want to back up your original files in case the Hot Folder is deleted, you can specify a location that is outside a
Hot Folder.

If you specify a different location, all original files from all Hot Folders will be saved in this common
location.

You can specify a different location for archiving original files, instead of the folder automatically generated by Hot
Folders, by setting the Save original files in option in Preferences. If you specify a different location, all original files
from all Hot Folders will be saved in this common location. For more information, see Set Hot Folders preferences
on page 9.

Backup Hot Folders

You access the Backup feature in the Fiery Hot Folders Console. A separate window opens that takes you through the
process.
1 In the Fiery Hot Folders Console, choose File > Backup & Restore.
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2 Click Backup and then click Next.

3 Specify any of these settings for the backup:

• File Name - Accept the default file name or type a new name for the backup file.

• Location - Set the location where your compressed backup files are saved.
If you want to replace an existing backup file rather than create a duplicate, you must set the same location as
the existing file and specify the same file name. Before the backup starts, Hot Folders asks whether to replace
the existing file.

• Add date to file name - Adds the current date to the file name. Use this option to automatically generate
unique file names for backup files created on different dates.

4 Click Next.

The Backup summary is displayed, and provides a hypertext link to the location specified for the backup files. For
each Hot Folder, the Backup summary indicates whether the backup succeeded (a green check mark) or failed (a red
"x").

Backup original files

Backup does not include original files, so you must save original files to a location outside a Hot Folder if you want to
back them up. However, if you specify a different location, all original files from all Hot Folders will be saved in this
common location.
1 In the Fiery Hot Folders Console, choose Edit > Preferences.

2 Click A common location and navigate to where you want to save the original files.

Restore Hot Folders

You can use the Restore feature to restore the Hot Folders and their settings to your system or to another system.
1 In the Fiery Hot Folders Console, choose File > Backup & Restore.

2 Click Restore, and then click Next.

3 Click one of the following;

• Click From a specific backup and browse to locate the backup file.

• Click From a recent backup and select from the list.

4 Click Next.

5 Click Browse and set the Restore Hot Folders to location.

6 To retain the original folder structure of the backup, select Keep original folder structure.
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7 If a Hot Folder you are trying to restore has the same name as an existing Hot Folder at the same location and you
still want to restore the Hot Folder, specify a different name for the restored Hot Folder.

Note: For renaming, the Hot Folders application provides a default folder name that is the original folder name
with "Rename" added to the beginning.

8 Click Next.

9 Review the Restore summary and do one of the following:

• If the restoring for all Hot Folders was successful, click OK.

• If any or all folders failed to be restored, make sure that you have permissions to read and write to the folder,
and click Retry.
The Retry button appears only if a folder failed in the restoring process. Retrying restores a new file.

Troubleshooting Hot Folders

If you have trouble with the Hot Folders application, there are several troubleshooting options.
For additional information or support, registered users may start a discussion through Fiery Communities.

Fiery server does not respond

• Do any of the following to troubleshoot:

• Make sure that the printer is turned on.
The printer may have been turned off, or the Power Saver mode function may have engaged.

• Make sure that the printer is connected.
If the administrator or operator has selected Suspend Printing, your print job will not resume until Resume
Printing is selected.

• Make sure that the Fiery server is on the network.
For more information, see Connect a Hot Folder to a Fiery server on page 7.

• Make sure that the Server Name and/or IP address has not changed.
If the IP address or Server Name changed, the administrator may need to edit the folder properties and
reconnect to the new Server Name or IP address. Alternatively, you can connect to a different Fiery server. For
more information, see Connect an existing Hot Folder to a different Fiery server on page 8.
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A Hot Folder cannot connect to a Fiery server

• Check the following:

• Make sure that the Fiery server is turned on.

• Make sure that the Hot Folder is activated.

• Make sure that Stop All Hot Folders is not enabled.
When you choose Stop All Hot Folders, jobs are not processed and all Hot Folders are disabled until you restart
all Hot Folders. Any added Hot Folders are disabled. For more information, see Stop and restart all Hot Folders
on page 10.

• If the Hot Folder is activated, try to open the connection with another utility, such as Command WorkStation.
If no other utilities connect, the problem may be with the Fiery server. If this happens, make sure the
connection is valid. Open the folder properties, and change the IP address to the server name.

• If you are using Mac OS and want to connect by using a server name, make sure the Search DNS Names
feature is configured on your system. If you do not have the feature configured, use the IP address of the Fiery
server. Contact your network administrator to enable the Search DNS Names feature.

A Hot Folder is missing from the Hot Folders Console

• Make sure you did not rename the Hot Folder with Windows or Mac OS file renaming features, rather than in the
Fiery Hot Folders Console. For more information, see Rename a Hot Folder on page 11.

My original file disappeared

The original file may have been moved without making a copy. (When you drag a file onto a Hot Folder on the same
disk partition as the source file, the file is moved, not copied.)
• Check inside the supporting folders. For more information, see Access original job files on page 11.

My job failed

The folder properties may not match the file and the folder may not support that type of file.
1 Access the log to view the status of the file.

2 Make sure the folder properties match your file and that you do not download a file that is not supported by a
folder. For example, if you download a JPEG file to a Hot Folder configured for a JDF filter, the job will fail.
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Maintain optimal performance

For the best performance in busy production environments, we recommend the following guidelines.

• Install the Fiery Hot Folders application on a separate computer, not on the Fiery server itself.

• Use Fiery Hot Folders on the Fiery server computer. However, do monitor the disk space that is available.

• Do not use the E: drive of the Fiery server for Fiery Hot Folders. The E: drive is used by Fiery system software to
store print jobs in queues, raster images, Paper Catalog, etc.

• Set a short interval for clearing jobs In the Fiery Hot Folders Console, choose Edit > Preferences (Windows) or
Fiery Hot Folders > Preferences (Mac OS), and choose a short interval for Clear original files.
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